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Računarsko modelovanje

CILJEVI

Cilj ovog poglavlja je dvojak. Prvo, ono treba da pruži pregled načina računarskog mode-
lovanja i drugo, treba da vam predstavi program Mechanical Desktop 2005 i upozna vas s 
njegovim korisničkim okruženjem. U ovom poglavlju upoznaćete ključne funkcije programa 
Mechanical Desktop 2005: parametarsko modelovanje punih tela zasnovano na konstruisanju 
njegovih elemenata, modelovanje sklopova, površinsko modelovanje i tehničko crtanje. 
Kada proučite ovo poglavlje, moći ćete da:

• opišete tri vrste računarskih modela;
• opišete glavne funkcije programa Mechanical Desktop;
• navedete glavne korake u konstruisanju parametarskih punih delova,  

sklopite pune delove i izradite odgovarajuće tehničke crteže;
• objasnite kako se koriste NURBS površine pri modelovanju tela proiz-

voljnog oblika

PREGLED
Za precizno prikazivanje projekta u industrijskom i inženjerskom projektovanju oduvek 
su se koristili modeli. Danas izrada trodimenzionalnih (3D) modela pomoću računara 
nudi više prednosti. Prvo, takvi modeli znatno olakšavaju naknadni proces kompjuter-
izovane proizvodnje delova. Drugo, pomoću virtuelnih sklopova modela možete da 
predstavite čitave proizvode ili sisteme. Na kraju, od 3D modela i virtuelnih sklopova 
možete da izradite klasične dvodimenzionalne (2D) tehničke crteže.

Program Mechanical Desktop 2005 izveden je iz AutoCAD-a 2005 i koristi isti for-
mat datoteka (DWG). Osim osnovnih računarskih funkcija za projektovanje koje ima 
i AutoCAD, Mechanical Desktop ima i četiri skupa alatki za projektovanje (tj. modu-
la) koji služe konstruisanju 3D modela, 3D površina, pravljenju sklopova i podsklopo-
va punih 3D modela, i pravljenju tehničke dokumentacije 3D tela, sklopova i površina.  
U alatke za projektovanje spadaju: modul za parametarsko modelovanje punih tela, mo-
dul za modelovanje sklopova, modul za površinsko modelovanje i modul za tehničko 
crtanje. Korisničko okruženje veoma liči na okruženje AutoCAD-a, ali Mechanical 
Desktop ima i pretraživač objekata (engl. object browser) koji omogućava da lako sagle-
date i hijerarhijski organizujete objekte u različitim prikazima i crtežima modela.
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KONCEPTI MODELOVANJA
Modeli su korisni u različitim fazama projektovanja proizvoda ili sistema jer omogućavaju da 
se proizvod ili sistem analiziraju i da se bolje sagleda njihova fizička priroda. Često se u tom 
cilju pred sam kraj projektovanja pravi maketa (engl. mock-up) modela. Međutim, pravljenje 
makete je skupo, a gotovu maketu je teško naknadno menjati. Zbog toga je velika prednost 
računarskog modelovanja to što vam omogućava da napravite model koji se može podesiti i 
izmeniti mnogo lakše od njegovog fizičkog parnjaka.

PREDSTAVLJANJE 3D OBJEKATA NA RAČUNARU
Pre nego što napravite računarski model, morate pažljivo razmotriti različite osobine objekta 
ili objekata koje model treba da predstavlja. Među njima su: geometrija objekta (oblik, profil i 
silueta), spoljni izgled (boja, tekstura) i svojstva (masa, težište i druga fizička svojstva).  U ovoj 
knjizi konstruisaćemo virtuelne modele 3D objekata držeći se uglavnom računarski konstru-
isanih digitalnih modela da bismo predstavili geometriju različitih proizvoda i sistema.

KLASIČAN 2D PRISTUP PROJEKTOVANJU
Klasičan pristup, po kome se 3D objekat predstavlja pomoću njegove tri ortogonalne 2D pro-
jekcije, ima više nedostataka. Prvo, on zahteva temeljno poznavanje nacrtne geometrije. Drugo, 
3D objekat proizvoljnog oblika teško se s dovoljnom tačnošću predstavlja pomoću njegove 
tri 2D projekcije. Slika 1-1 prikazuje tehnički crtež sa tri 2D projekcije automobilske školjke. 
Pošto siluete i profili nisu jasno prikazani, na crtežu nema dovoljno podataka potrebnih za 
proizvodnju školjke.

Slika 1-1 Tehnički crtež objekta proizvoljnog oblika

3D MODELI
U osnovi postoje tri vrste računarskih 3D modela: žičani (engl. wireframe), površinski (engl. 
surface) i puni (engl. solid) model. Razlike među njima mogu se ilustrovati na modelu pravo-
ugaone kutije. Žičani model kutije sastoji se od 12 pravolinijskih segmenata. Njen površinski 
model sadrži šest površina. Puni model kutije predstavlja jedinstven, pun objekat (koji ima 
zapreminu).
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ŽIČANI MODELI
Žičani modeli se na računaru prave najjednostavnije. Žičani model predstavlja 3D objekat 
pomoću skupa međusobno nepovezanih krivih koje čine ivice 3D objekta. Model je samo ble-
da senka 3D objekta – krive nisu ni u kakvom međusobnom odnosu. Shodno tome, žičani mo-
del ne sadrži nikakve informacije o površinama ili zapremini – samo o ivicama i temenima. Vi 
treba da međusobno povežete krive da biste mogli da zamislite površinu i zapreminu objekta. 
Na slici 1-2 prikazan je žičani model objekta proizvoljnog oblika. Na njoj se vide samo ivice na 
kojima se susreću površine, ali samih površina nema u modelu. Pošto nema podataka o površini 
i zapremini objekta, a „žice“ su bez debljine, model ne možete da prikažete realistično.

Slika 1-2 Žičani model objekta proizvoljnog oblika

Ponekada žičani model izaziva nedoumice. Jednostavna kockasta kutija na slici 1-3 prika-
zana je levo kao žičani model, dok je desno nekoliko mogućih 3D objekata koje možete iz-
vesti iz tog modela.

ŽIÅANI MODEL MOGUÑI 3D OBJEKTI

Slika 1-3 Zbunjujući žičani model

Žičani model ima ograničenu primenu u proizvodnji delova. Takvi modeli se koriste za 2-1/2D 
CNC mašine i 2D profilisanje. Pomoću žičanog modela ne možete da procenite masena svojstva 
objekta, da otkrijete neslaganje sastavnih delova niti da izvedete druge važne analize.
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POVRŠINSKI MODELI
Površinski 3D model je skup 3D površina koje se u 3D prostoru spajaju u objekat. U poređenju 
sa žičanim 3D modelom, površinski 3D model – osim podataka o ivicama – sadrži i infor-
macije o konturama i siluetama površina. Površinske 3D modele možete da upotebite u 
kompjuterizovanom sistemu proizvodnje, za realistično prikazivanje modela i za animaci-
je. Pošto površinski model predstavlja skup površina, za njegovo pravljenje potrebno je kon-
struisati pojedinačne površine. One se najlakše konstruišu ako nacrtate skup krivih od kojih 
računar automatski stvara površinu. Na slici 1-4 prikazan je skup krivih zajedno s površinom 
konstruisanom od njih.

Slika 1-4 Krive i površina konstruisana od njih

Površinski model možete da sastavite od skupa pojedinačnih površina. Na slici 1-5 prika-
zan je površinski model s rasklopljenim površinama (engl. exploded surfaces). Na slici 1-6 dat 
je realističan prikaz površinskog modela.

Slika 1-5 Površinski model s rasklopljenim površinama
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Slika 1-6 Realističan prikaz površinskog modela

PUNI MODELI
Puni 3D modeli (engl. 3D solid models) sadrže najviše podataka o objektu. Oni obuhvataju 
integrisane matematičke podatke o površinama, ivicama i zapremini objekta. Osim za vizu-
elizovanje i proizvodnju, podatke koje sadrži pun model možete da iskoristite i za projektne 
proračune. Na slici 1-7 prikazan je pun model cilindričnog zupčanika.

Slika 1-7 Pun model cilindričnog zupčanika

Pošto su 3D objekti jedinstvenog oblika, integrisani podaci potrebni za prikazivanje pu-
nog tela složeniji su nego oni za prikazivanje površinskog ili žičanog modela. Puni modeli se 
konstruišu najčešće od skupa krivih koje se zatim transformišu pomoću četiri osnovne metode: 
izvlačenjem (engl. extrude), obrtanjem (engl. revolve), složenim izvlačenjem duž putanje (engl. 
loft) i prostim izvlačenjem duž putanje (engl. sweep) (slike 1-8 i 1-9).
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IZVLAÅEÇE
(EXTRUDE)

OBRTANJE
(REVOLVE)

SLOÆENO 
IZVLAÅEÇE DUÆ 
PUTAÇE (LOFT)

PROSTO IZVLAÅEÇE
DUÆ PUTAÇE (SWEEP)

Slika 1-8 Četiri osnovna postupka s krivom

Slika 1-9 Realističan prikaz izvučenog tela, obrtnog tela, tela izvučenog metodom loft i tela izvučenog 
metodom sweep

U osnovi, složena puna tela konstruišu se tako što se prvo naprave osnovni oblici punih tela 
koji se zatim kombinuju logičkim (Bulovim) operacijama. Na primer, cilindrični zupčanik sa 
slike 1-7 predstavlja kombinaciju dobijenu izvlačenjem i obrtanjem. Telo zupčanika dobijeno 
je obrtanjem, a svaki zubac je naknadno dobijen izvlačenjem (slika 1-10).

Slika 1-10 Izvučeno puno telo (zubac) usečeno u obrtno puno telo (telo zupčanika)

IZBOR MODELA
Žičani model predstavlja samo ivice i temena 3D objekta. Zbog nedostatka informacija o 
površini i zapremini objekta, on ima vrlo ograničenu primenu u proizvodnji. Osim ivica i te-
mena, površinski model sadrži površine i siluete 3D objekta. Kada uporedimo površinski i pun 
model, treba reći da se pun model lakše konstruiše. Međutim, on nepotpuno prikazuje složene 
objekte proizvoljnog oblika. Za predstavljanje 3D objekata koji imaju složene profile i siluete, 
neophodan je površinski model.

Sve u svemu, puni 3D modeli pogodniji su za konstruisanje 3D objekata pravilnih geomet-
rijskih oblika, dok su površinski 3D modeli prevashodno namenjeni konstruisanju 3D ob-
jekata proizvoljnog oblika. (Ako imate površinski model sastavljen od skupa površina koje 
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„hermetički“ obuhvataju određenu zapreminu, možete ga pretvoriti u pun model.) Iako se 
3D krive ne koriste za konstruisanje žičanih 3D modela, možete ih iskoristiti kao podlogu za 
pravljenje 3D površina i punih 3D tela.

METODE MODELOVANJA
Kada želite da konstruišete računarski 3D model, osmotrite objekat u celini i razmislite o 
tome kako da ga razbijete na jednostavnije elemente. Zatim konstruišite osnovne elemente i 
spojite ih u 3D model. Elementi na koje ćete rastaviti objekat zavise od vrste 3D modela koji 
želite da konstruišete.

Za konstruisanje žičanog modela, razmišljajte o ivicama na kojima se susreću dve strane 
3D modela. Ne zaboravite ni podrazumevane ivice na mestima gde površine prelaze u svoje 
tangentne ravni. Konstruisanje žičanog modela je mukotrpan posao jer morate da unosite 3D 
koordinate da biste definisali žice. Da biste konstruisali jednostavnu kocku, treba da definišete 
12 pravih u 3D prostoru. Kada su ivice zakrivljene, posao je još složeniji.

Kod površinskog modela razmišljajte najpre kako da 3D objekat razbijete na pojedinačne 
površine. Zatim napravite površine tako što ćete konstruisati skupove krivih koje će računar 
automatski povezati u površine. Površina se generiše gotovo automatski, ali je konstruisanje 
skupa krivih složeno.

Kada želite pun model, rastavite 3D objekat na jednostavne pune elemente, konstruišite 
elemente i sklopite ih u 3D objekat. Ako koristite parametarski postupak (koji objašnjavamo 
kasnije u poglavlju), modelovanje punog objekta mnogo je lakše od površinskog modelovanja 
ili pravljenja žičanog modela.

MODELOVANJE SKLOPA
Proizvod ili sistem obično ima više komponenata (tj. sastavnih delova). Modeli sklopova se 
prave tako što se više komponenata uključuje u jedinstvenu datoteku sklopa (engl. assembly 
file). Pošto definicije 3D modela već postoje u datotekama pojedinačnih komponenata, datote-
ka sklopa samo opisuje način sklapanja komponenata i njihove geometrijske odnose. Na slici 
1-11 prikazan je sklop dečjeg automobila.

Slika 1-11 Sklop dečjeg automobila
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TEHNIČKO CRTANJE
Iako se u većini savremenih fabrika koriste računarski modeli, ponekad treba odgovoriti na 
specijalne zahteve i izraditi tehničke 2D crteže. Konstruisanje ortogonalnih 2D projekcija na 
osnovu računarskog 3D modela izvodi se veoma lako: samo zadate prikaze (engl. views) i nji-
hovu poziciju, a program ostalo radi sam. Crteži se zatim upotpunjavaju oznakama (engl. an-
notations). Na slici 1-12 prikazan je tehnički crtež izrađen na osnovu modela sklopa dečjeg 
automobila.

Slika 1-12 Tehnički crtež

RAD S PROGRAMOM MECHANICAL DESKTOP
Mechanical Desktop 2005 je alatka za industrijsko i inženjersko 3D projektovanje, integrisana 
u AutoCAD 2005. Mechanical Desktop koristi format datoteka s crtežima (DWG) svojstven 
AutoCAD-u i proširuje mogućnosti tog programa pomoću četiri glavne funkcije:

• Parametarsko modelovanje punih tela (engl. parametric solid modeling)

• Modelovanje sklopova (engl. assembly modeling)

• Površinsko modelovanje (engl. surface modeling)

• Tehničko crtanje (engl. engineering drafting)

TIPOVI DATOTEKA
Iako je Mechanical Desktop nadogradnja AutoCAD-a 2005, on ima dve jasno razgraničene 
vrste datoteka: datoteke delova (engl. part files) i datoteke sklopova (engl. assembly files). Datoteke 
delova se koriste za pravljenje punih delova, dok datoteke sklopova služe za konstruisanje 
sklopova. Iako za pravljenje površina možete upotrebiti i jedan i drugi tip datoteka, zbog do-
slednosti bi trebalo da za to koristite datoteke delova.
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Datoteke delova
Kao u AutoCAD-u, datoteka delova ima dva radna okruženja: okruženje za modelovanje (Mod-
el) i okruženje za crtanje (Drawing). Pune delove (engl. solid parts) konstruišete u okruženju za 
modelovanje, dok tehničke crteže punih delova izrađujete u okruženju za crtanje. Kada želite 
da otvorite novu datoteku delova, iz menija File izaberite stavku New Part File.

File>New Part File

Datoteke sklopova
Datoteka sklopa ima tri radna okruženja: za modelovanje (Model), za scenu (Scene) i za 
crtanje (Drawing). Puni delovi i sklopovi, kao i podsklopovi punih delova, konstruišu se u 
okruženju Model. Izgled sklopa u rasklopljenom stanju (scena) konstruiše se u okruženju 
Scene, a tehnički crteži sklopa – u okruženju Drawing. Novu datoteku sklopa otvarate kom-
andom New iz menija File.

File>New

KORISNIČKO OKRUŽENJE
Korisničko okruženje (engl. user interface) programa Mechanical Desktop veoma liči na 
okruženje AutoCAD-a. Osim uobičajenog skupa komponenata radne površine AutoCAD-
a, u Mechanical Desktopu postoji i  pretraživač – Desktop Browser, prikazan na desnoj stra-
ni slike 1-13.

Slika 1-13 Korisničko okruženje programa Mechanical Desktop

Desktop Browser
Desktop Browser prikazuje objekte konstruisane u različitim radnim okruženjima (za mode-
lovanje, za scenu i za crtanje) i obezbeđuje prečice ka komandama u priručnom (kontekstnom) 
meniju. Za svaki od dva tipa datoteka (delova i sklopova) postoji posebna varijanta Desktop 
Browsera. Za datoteku delova, Desktop Browser ima dve kartice (Model i Drawing), dok za 
datoteku sklopova ima tri kartice (Model, Scene i Drawing).



01_MDE5.indd    strana 10

10

Kartica Model prikazuje objekte punog dela ili sastavne delove sklopa. Kartica Scene 
prikazuje objekte u scenama sklopa, a kartica Drawing objekte crteža. Slika 1-13 prikazuje 
pretraživač datoteke sklopa, a slika 1-14 korisničko okruženje datoteke delova. Kada želite da 
nešto radite sa objektom u datoteci, izaberite ga u pretraživaču, pritisnite desni taster miša i iz 
priručnog menija izaberite odgovarajuću komandu (slika 1-15). Ako pretraživač nije na ekra-
nu, izaberite stavku Desktop Browser iz podmenija Display menija View.

View>Display>Desktop Browser

Slika 1-14 Korisničko okruženje datoteke delova

Slika 1-15 Priručni meni u pretraživaču
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Sistem menija
U vrhu ekrana nalazi se 15 menija. Meniji Surface, Part, Assembly i Drawing sadrže četiri glavne 
alatke za projektovanje Mechanical Desktopa. Ako ne vidite ove menije, upišite MENULOAD 
na komandnu  liniju i pritisnite taster Enter. Otvoriće se okvir za dijalog Menu Customization 
(slika 1-16). Pritisnite dugme Browse i izaberite željenu datoteku s menijima (amdtacad.mns). 
U prozoru Select Menu File pritisnite dugme Open, što će vas vratiti u okvir za dijalog Menu 
Customization. Pritisnite dugme Load; ime datoteke će se pojaviti na listi Menu Groups. Pri-
tisnite dugme Close da biste se vratili na radnu površinu (engl. desktop).

Slika 1-16 Okvir za dijalog Menu Customization

Palete alatki
Ispod trake menija (engl. menu bar) nalazi se glavna paleta alatki (engl. toolbar) – Desktop 
Main (prikazana u neusidrenom stanju na slici 1-17). Pošto su programi Mechanical Desk-
top i AutoCAD međusobno integrisani, na paleti su na raspolaganju komande iz oba pro-
grama. Međutim, zbog ograničenog prostora u menijima i prozoru, pored menija i paleti alatki 
Mechanical Desktopa prikazani su samo osnovni meniji komandi AutoCAD-a. Palete alat-
ki su grupisane prema srodnim poslovima (modelovanje dela, modelovanje sklopa, konstruisa-
nje scene i tehničko crtanje). Da biste prikazali paletu alatki Surface Modeling (slika 1-29), iz 
menija Surface izaberite stavku Launch Toolbar. 

Slika 1-17 Glavna paleta alatki – Desktop Main
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Kada hoćete da prikažete palete alatki koje nisu na ekranu, iz podmenija Toolbars meni-
ja View izaberite stavku Customize Toolbars. U okviru za dijalog Customize izaberite karti-
cu Toolbars, a zatim na listi Toolbars unesite znak potvrde u polja pored paleta koje želite da 
prikažete (slika 1-18).

View>Toolbars>Customize Toolbars

Slika 1-18 Kartica Toolbars u okviru za dijalog Customize

Skrivene palete alatki prikazaćete i ako desnim tasterom miša pritisnete bilo koju vidljivu 
paletu alatki i zatim ih izaberete iz priručnog menija.

UNOŠENJE KOMANDI
Kada menije i palete alatki rasporedite po radnoj površini onako kako vam odgovara, koman-
de Mechanical Desktopa možete da izvršavate na više načina:

• Biranjem stavke iz menija

• Pritiskanjem dugmeta na paleti alatki

• Upisivanjem komande na komandnu liniju

• Biranjem iz kontekstnog menija koji se otvara kada desnim tasterom miša pritiskate različite 
delove radne površine

• Pritiskajući dvaput objekat u Desktop Browseru

SLOJEVI
Pri radu u Mechanical Desktopu sretaćete se s više slojeva (engl. layers) čija imena počinju 
na AM. Mechanical Desktop ih koristi iz određenih razloga. Ti slojevi se generišu automat-
ski. Oni sadrže različite objekte, kao što su vidljive linije, skrivene linije, granice rakursa (engl. 
viewport borders) tehničkih crteža konstruisanih od punog dela ili sklopa punih delova. Nemo-
jte im menjati imena.
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ALATKE AUTOCADA 2005
Alatke AutoCAD-a koristite da biste konstruisali krive, neophodne za pravljenje površina i 
punih tela, te da biste napravili zaglavlja i uneli odgovarajuće oznake na tehničke crteže.

MODUL ZA PARAMETARSKO MODELOVANJE PUNIH TELA
Prva generacija modela punih tela izrađenih na računaru bila je najčešće statična, što znači 
da se pun model konstruisan od krivih nije mogao naknadno menjati (dubokim izvlačenjem, 
obrtanjem, i izvlačenjem duž putanja metodama loft i sweep). S pojavom snažnijih računara i 
savršenijih programa za 3D modelovanje, postalo je moguće da se parametri punog tela menjaju 
bilo kad u procesu projektovanja. Prvobitna puna tela – ona statična – obično se označavaju kao 
neparametarska puna tela (engl. non-parametric solids) (AutoCAD-ova puna tela), dok se ona 
druga nazivaju parametarskim punim telima (engl. parametric solids). Parametarska puna tela 
modifikuju se menjanjem vrednosti njihovih mera (engl. dimensions). Zbog toga je i odgovarajući 
sistem modelovanja poznat kao sistem modelovanja parametarskih punih tela na osnovu me-
njanja njihovih mera (engl. dimension-driven parametric solid model system).

Modul za modelovanje delova Mechanical Desktopa jeste sistem za modelovanje parametar-
skih punih delova zasnovan na karakteristikama, tj. elementima (engl. features). Kada želite da 
konstruišete pun model 3D objekta, prvo analizirajte objekat i razložite ga na elemente punog 
tela, a zatim konstruišete elemente jedan po jedan. Pošto je puno telo razloženo na elemente, 
a parametri elemenata se mogu menjati, puno telo se zove parametarsko puno telo zasnovano 
na elementima (engl. parametric feature-based solid).

Kada konstruišete pun element (engl. solid feature), prvo pomoću AutoCAD-ovih alat-
ki napravite grubu skicu (engl. rough sketch). Zatim je pomoću alatki Mechanical Desktopa 
konvertujete (engl. resolve) u parametarsku skicu (engl. parametric sketch) i od nje konstruišete 
pun element. Za složen puni element prvo napravite pojedinačne elemente, a zatim ih povežite 
logičkim operacijama. Na slici 1-19 dat je pun objekat dobijen spajanjem elemenata nasta-
lih pomoću četiri metode – izvlačenjem, obrtanjem, složenim izvlačenjem duž putanje (loft) 
i prostim izvlačenjem duž putanje (sweep). Elementi punog tela koji su konstruisani od skica 
zovu se elementi skiciranog punog tela (engl. sketched solid features).

Slika 1-19 Puno telo sa četiri skicirana elementa: izvučenim (centar), obrtnim (gornji deo), elementom 
dobijenim pomoću metode loft (levi kraj) i elementom dobijenim pomoću metode sweep 
(desni kraj)

Osim elemenata skiciranog punog tela, postoje i gotovi puni elementi (engl. pre-construct-
ed solid features). Dodajete ih modelu tako što ih birate iz menija ili sa paleta i zadajete im 
parametre i položaj. Pošto ih konstruišete tako što ih postavljate u model, to su postavlje-
ni puni elementi (engl. placed solid features), no mi ćemo ih zvati gotovi puni elementi. Na slici  



01_MDE5.indd    strana 14

14

1-20 prikazan je pun model sa četiri vrste gotovih punih elemenata (zarubljenje – engl. cham-
fer, zaobljenje – engl. fillet, otvor – engl. hole i školjka – engl. shell).

Slika 1-20 Puno telo sa četiri vrste gotovih punih elemenata (zarubljenje, zaobljenje, otvor i školjka)

Kada konstruišete pun element, koristite i radne elemente (engl. work features) kao geometrij-
ske reference. Prema tome, pun deo može da ima tri vrste punih elemenata: skiciranog tela, 
gotove i radne.

Na slici 1-21 prikazani su meni Part i paleta alatki Part Modeling u programu Mechani-
cal Desktop. Pomoću tog menija i te palete možete da konstruišete parametarske pune delove 
zasnovane na elementima.

Slika 1-21 Meni Part i paleta alatki Part Modeling u programu Mechanical Desktop

Ako ste već radili u AutoCAD-u, verovatno znate da i on ima zbirku alatki za modelova-
nje punih tela. (Pogledajte na slici 1-22 podmeni Solids menija Design.) Za razliku od para-
metarskih alatki, ova zbirka alatki omogućava konstruisanje samo neparametarskih punih tela 
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(tj. AutoCAD-ovih matičnih punih tela). Zapamtite, parametarska puna tela konstruišu se 
alatkama Mechanical Desktopa, a neparametarska puna tela – alatkama AutoCAD-a.

Slika 1-22 Podmeni Solids menija Design

U 2. poglavlju naučićete da konstruišete parametarske skice, a u 3, 4. i 8. poglavlju – kako 
se prave parametarska puna tela.

MODUL ZA MODELOVANJE SKLOPOVA
Modul za modelovanje sklopova (engl. assembly modeling module) predstavlja jedinstven skup 
alatki za okupljanje komponenata u sklop nekog proizvoda ili sistema. Komponente sklopa su, 
u stvari, njegovi pojedinačni sastavni delovi. Međutim, ako radite s proizvodom ili sistemom 
koji imaju veliki broj delova, pogodnije je i praktičnije da delove slažete u manje podsklopove 
(engl. subassemblies) koje kasnije objedinjujete u konačan sklop. Prema tome, komponente sklo-
pa u ovom smislu jesu puni delovi ili podsklopovi.

Konstruisanje sklopa podrazumeva povezivanje zbirke potrebnih komponenata (punih 
delova ili podsklopova), razmeštanje komponenata na odgovarajuće pozicije i uspostavljanje 
odnosa među njima. Sve to postižete primenjujući uslove sklapanja (engl. assembly constraints) 
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na odabrane parove elemenata komponenata. Sklop koristite da biste modelovali čitav proiz-
vod ili sistem, da biste sagledali sklop u celini, proverili eventualno neslaganje komponenata i 
prikazali izgled proizvoda ili sistema u rasklopljenom stanju. Na slici 1-23 prikazani su meni 
Assembly i paleta alatki Assembly Modeling u programu Mechanical Desktop.

Slika 1-23 Meni Assembly i paleta alatki Assembly Modeling u programu Mechanical Desktop

U 5. poglavlju naučićete da od komponenata konstruišete sklopove, a u 6. – kako se prave 
scene (izgled sklopa u rasklopljenom stanju).

MODUL ZA POVRŠINSKO MODELOVANJE
Površinski modeli se najčešće koriste za predstavljanje 3D objekata proizvoljnog oblika (engl. 
free-form objects). Kada želite da napravite površinski model, prvo treba da konstruišete nje-
gov skelet (engl. framework) od 3D krivih. Posle toga zadajete vrstu površine koju računar au-
tomatski generiše.

Modul za površinsko modelovanje je sistem površinskog modelovanja koji radi pomoću 
objekata tipa NURBS (neuniformna racionalna kriva tipa B − engl. Non-Uniform Rational  
B-Spline) i namenjen je projektovanju i proizvodnji. Možete ga upotrebiti za konstruisanje 
površina proizvoljnog oblika (engl. free-form surfaces) (slika 1-24). On obuhvata i skup alat-
ki za konstruisanje i modifikovanje 3D krivih pomoću kojih možete da napravite složen ske-
let kao podlogu za površinu.

Slika 1-24 Površina proizvoljnog oblika
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Modul ostvaruje i vezu između površina i punih tela tako što vam omogućava da:
• površini dodelite debljinu i tako je pretvorite u puno telo sa 3D profilom proizvoljnog oblika

• međusobno povežete (engl. stitch) više „nepropusnih“ površina u jedno puno 3D telo proiz-
voljnog oblika

• površinu upotrebite kao oštricu za prosecanje punog tela

Možete takođe i da povezanu površinu, AutoCAD-ovo matično puno telo ili puno telo na-
pravljeno u Mechanical Desktopu pretvorite u skup NURBS površina (slike 1-25 do 1-28).

Slika 1-25 Puno telo konstruisano tako što je površini dodeljena debljina

Slika 1-26 Prikaz odozgo punog modela automobilske školjke konstruisanog od skupa povezanih 
površina

Slika 1-27 Puno telo presečeno površinom
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Slika 1-28 Puno telo pretvoreno u skup površina

Na slici 1-29 prikazani su meni Surface i paleta alatki Surface Modeling u programu Me-
chanical Desktop. Nemojte ih mešati sa AutoCAD-ovim alatkama za površine (iz podmenija 
Surfaces menija Design i s palete alatki Surfaces) koje su prikazane na slici 1-30. 

Slika 1-29 Meni Surfaces i paleta alatki Surface Modeling u programu Mechanical Desktop

Slika 1-30 Podmeni Surfaces menija Design i paleta alatki Surfaces u AutoCAD-u
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Alatke za rad s površinama u AutoCAD-u znatno su jednostavnije – one definišu površinu 
kao poligonalnu mrežu (engl. polygon mesh). Svaka složena glatka površina predstavlja se 
mrežom sastavljenom od poligonalnih faseta (engl. polygonal face) i krivolinijskih ivica 
izgrađenih od pravolinijskih segmenata. Na slici 1-31 prikazan je skup površinskih mreža  
(engl. surface meshes) koje samo približno predstavljaju prvobitne površine. Nasuprot tome, 
površine koje konstruišete alatkama programa Mechanical Desktop, predstavljaju glatke, 
neprekidne površine, tako da možete dobiti tačne koordinate svake tačke površine. Kako se 
prave površinski modeli naučićete u 7. poglavlju.

Slika 1-31 Površine predstavljene poligonalnim mrežama, dobijene alatkama za rad s površinama  
u AutoCAD-u

MODUL ZA TEHNIČKO CRTANJE
Modul za crtanje i označavanje (engl. drawing and annotation module) (zvan i modul za tehničko 
crtanje) generiše tehničke 2D crteže međusobno povezanih prikaza površina, punih tela i sklo-
pova, i omogućava da generisane crteže označite na odgovarajući način. Pošto konstruišete 3D 
model, generisanje tehničkih crteža ide poluautomatski. Pomoću modula za crtanje treba da 
zadate samo prikaze i njihovu razmeru (engl. scale), a računar ostalo radi sam. Pošto napravite 
crteže kakve želite, možete u njih uneti odgovarajuće oznake (engl. annotations). Na slika-
ma 1-32 i 1-33 prikazani su meniji Drawing i Annotate, i paleta alatki Drawing Layout pro-
grama Mechanical Desktop. U 9. poglavlju naučićete da pravite tehničke crteže punih delova 
i površina, a u 10. poglavlju – tehničke crteže sklopova.
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Slika 1-32 Meni Drawing i paleta alatki Drawing Layout programa Mechanical Desktop

Slika 1-33 Meni Annotate
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KOMPATIBILNOST I SARADNJA SA AUTOCADOM
Naglasimo još jednom, Mechanical Desktop 2005 je nadogradnja AutoCAD-a 2005 i kori-
sti datoteke njegovog matičnog formata (DWG). Prema tome, puna tela i površine izrađeni u 
Mechanical Desktopu i AutoCAD-ova matična puna tela potpuno su međusobno kompati-
bilni. Možete ih kombinovati bez ograničenja.

AutoCAD-ova matična puna tela
AutoCAD-ovo matično puno telo (engl. native solid) možete da pretvorite u osnovni element 
punog tela (engl. base solid feature) u Mechanical Desktopu, kome možete da dodajete druge 
parametarske pune elemente. Isto tako, fasete AutoCAD-ovog matičnog punog tela možete 
da pretvorite u skup NURBS površina.

Površine Mechanical Desktopa
U Mechanical Desktopu možete da više nepropusnih površina povežete u jedinstveno puno 
telo. Pomoću NURBS površine kao površinskog elementa, možete da prosečete dobijeno puno 
telo ili matično telo AutoCAD-a.

Parametarska puna tela Mechanical Desktopa
Parametarsko puno telo napravljeno u Mechanical Desktopu možete da pretvorite u AutoCAD-
-ovo matično puno telo. Parametarsko telo možete i da pretvorite u skup NURBS površina.

OPCIJE
Podešavanja u okviru za dijalog Options određuju način rada sistema i ono što vidite na ekra-
nu (slika 1-34).

Izaberite Assist>Options

Slika 1-34 Okvir za dijalog Options

Okvir za dijalog Options ima više kartica koje se odnose na različite poslove. Počnimo, 
na primer, od kartice User Preferences. Ovde, između ostalog, treba da budu izabrane opci-
je Synchronize Browser with Modes i Synchronize Toolbars with Modes. Kada ih izaberete, 
pretraživač i palete alatki sinhronizovaće se s radnim okruženjem (Model, Scene i Drawing). 
Okvir za dijalog zatvarate pritiskajući dugme OK.
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PITANJA ZA PROVERU ZNANJA

1. Navedite tri vrste 3D modela i ukratko opišite njihove osobine.

2. Navedite četiri modula (alatke) Mechanical Desktopa i opišite njihove glavne funkcije.

3. Na koliko načina možete da izvršite komandu Mechanical Desktopa? Navedite ih.

4. Kako ćete modelovati proizvod ili sistem koji se sastoji od više komponenata?

5. Kako ćete napraviti tehnički crtež 3D modela?

SAŽETAK

Osnovni cilj korišćenja računarskog modela jeste tačno predstavljanje 3D objekta u raču-
naru. Postoje tri vrste računarskih modela (žičani, površinski i pun model). Pun model 
sadrži najviše podataka o objektu i najpogodniji je za kasniju primenu u proizvodnji. 
Površinski modeli bolje predstavljaju složene 3D objekte proizvoljnog oblika. Prema tome, 
metode modelovanja pomoću punog tela (izvlačenje, obrtanje, loft i sweep) primenićete 
na 3D objekte pravilnih oblika, a metode površinskog modelovanja – na složene objekte 
proizvoljnog oblika. Ako vam treba pun model objekta složenog oblika, pretvorite njegov 
hermetički zatvoren površinski model u pun model. Žičani modeli imaju ograničenu 
primenu u računarskom modelovanju. Ipak, ponekad treba da napravite žičani skelet kao 
podlogu za površinski ili pun model.

Mechanical Desktop 2005 je programska alatka za inženjersko projektovanje koja se 
izvršava u AutoCAD-u 2005. Program sadrži četiri modula: za modelovanje parametarskih 
punih tela, za modelovanje sklopova, za površinsko modelovanje i za tehničko crtanje.

Pomoću modula za modelovanje parametarskih punih tela možete da konstruišete para-
metarske pune delove zasnovane na elementima. Puna tela se konstruišu od grubih skica  
i gotovih elemenata, i mogu se podešavati. U puno telo mogu se uključiti i površine.

Modul za modelovanje sklopova omogućava da konstruišete sklop komponenata – punih 
delova ili podsklopova punih delova. Pomoću njega možete i da prikažete sklop u rasklop-
ljenom stanju.

Pomoću modula za površinsko modelovanje možete da konstruišete površine proizvoljnih 
oblika i da ih upotrebite za pravljenje punih delova.

Pomoću modula za inženjersko crtanje možete da izradite tehničke crteže punih tela, 
sklopova i površina.

Korisničko okruženje Mechanical Desktopa veoma liči na okruženje AutoCAD-a, uz neko-
liko bitnih razlika. U njemu postoje dodatne stavke u menijima, neki meniji su preuređeni, 
a tu je i pretraživač – Desktop Browser – koji prikazuje objekte iz datoteke delova ili 
datoteke sklopova i obezbeđuje prečice ka komandama.
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CILJEVI

Cilj ovog poglavlja je da vas uvede u osnovne koncepte parametarskog skiciranja, da opiše 
osnovne korake konstruisanja parametarske skice i da vam pomogne da uvežbate razne 
tehnike skiciranja. Kada proučite ovo poglavlje, moći ćete da:

• objasnite osnovne koncepte parametarskog skiciranja
• objasnite značenje uslova
• pomoću različitih tehnika napravite parametarsku skicu

PREGLED
Pravljenje svakog punog modela zasnovanog na elementima počinje od pravljenja gru-
be skice koja, dakle, ne mora da bude tačna. Telo konstruišete polazeći od skice. Dok 
je pravite, koncentrišite se na njen oblik – tačna geometrija i veličina skice nisu važni. 
Skica koju konstruišete podrazumevano je neparametarska jer je pravite u okruženju 
AutoCAD-a, a Mechanical Desktop je njegov programski dodatak. Kada želite da ne-
parametarsku AutoCAD skicu pretvorite u parametarsku skicu Mechanical Desktopa, 
morate prvo da je konvertujete (engl. resolve), a zatim da na takvu skicu primenite 
odgovarajuće geometrijske uslove i parametarske mere.

KONCEPTI PARAMETARSKOG SKICIRANJA
Na početku projektovanja uvek ćete više voditi računa o oblicima, nego o merama. 
Međutim, u mnogim klasičnim programima za računarsko projektovanje, neophodno 
je da od samog početka zadate tačne dužine i orijentaciju elemenata. U početnoj fazi 
projektovanja takvim podacima obično ne raspolažete, pa u programu Mechanical Desk-
top i nije potrebno da ih unosite.

SKICIRANJE
Modul Part programa Mechanical Desktop služi kao elektronska tabla za crtanje na 
kojoj možete zabeležiti svoju zamisao. Počnite crtajući grube skice, a mere ćete zada-
vati kasnije. Na skici mere nisu važne, linije ne moraju da budu strogo horizontalne ili 
vertikalne, a objekti ne moraju biti tačno povezani svojim krajevima. U stvari, treba da 
se koncentrišete isključivo na oblike. O merama ćete razmišljati kasnije.

23
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Pošto je Mechanical Desktop nadgradnja AutoCAD-a, skica koju konstruišete po defini-
ciji je neparametarska AutoCAD skica. Da biste je pretvorili u parametarsku skicu, treba da 
dopustite Mechanical Desktopu da je konvertuje (engl. resolve). U zavisnosti od toga kako 
nameravate da upotrebite parametarsku skicu, transformišite je u jedan od sledećih objekata: 
profil, putanju, liniju preloma, liniju preseka ili liniju cepanja. Osim ovakvih skica, možete 
skicirati i tekst da biste ga posebno istakli. Evo liste pomenutih objekata:

• Profil (engl. profile) – presek za izvlačenje, rotiranje, prosto izvlačenje duž putanje (sweep) i 
složeno izvlačenje duž putanje (loft)

• Putanja (engl. path) – vođica (engl. guide rail) za prosto izvlačenje duž putanje

• Linija preloma (engl. break line) – za definisanje prikaza delimičnog preseka (engl. breakout 
section drawing view)

• Linija preseka (engl. cut line) – za definisanje presečne ravni u prikazu izdvojenog (engl. off-
set) ili uporednog (engl. aligned) preseka

• Linija cepanja (engl. split line) – za cepanje stranice punog tela na dve stranice ili za cepanje 
punog dela na dva dela

• Skica teksta (engl. text sketch) – za isticanje teksta

Naučićete kako se skica transformiše u profil (slika 2-1) i kako se konstruiše skica teksta 
(engl. text sketch) (slika 2-2). U 3. poglavlju naučićete da koristite putanje, u 9. – kako se ko-
riste linije preloma i preseka, a u 8. – ako se koristi linija cepanja.

Slika 2-1 Skica profila

Slika 2-2 Skica teksta

Kada transformiše skicu, Mechanical Desktop podrazumevano primenjuje sledeći skup 
pravila:

• Prave koje su približno horizontalne postaju strogo horizontalne.

• Prave koje su približno vertikalne postaju strogo vertikalne.

• Približno upravne prave postaju strogo upravne.

• Približno paralelne prave postaju strogo paralelne.

• Približno tangencijalne prave, lukovi i krugovi postaju strogo tangencijalni.

• Ako prave leže približno na istoj pravoj, postaće kolinearne.
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• Ako su lukovi i krugovi približno koncentrični, postaće koncentrični.

• Centri lukova i krugova dobiće istu koordinatu X, ako su im koordinate X skoro jednake.

• Centri lukova i krugova dobiće istu koordinatu Y, ako su im koordinate Y skoro jednake.

• Krajnje tačke duži imaće iste koordinate X, ako su im koordinate X približno jednake.

• Krajnje tačke duži imaće iste koordinate Y, ako su im koordinate Y približno jednake.

• Lukovi i krugovi dobiće isti poluprečnik ako su im poluprečnici približno isti.

• Duži će postati iste dužine ako su im dužine približno jednake.

Drugi skup pravila tiče se međusobnog spajanja objekata i pridruživanja jednog objekta 
drugom:

• Ako su objekti međusobno dovoljno blizu, biće im spojene krajnje tačke.

• Krajnje tačke u blizini prave, luka ili kruga biće spojene s pravom, lukom ili krugom.

Pre nego što konvertovanu skicu upotrebite za bilo koju operaciju, treba da je u potpunosti 
uslovite, jer kasnije, kada budete podešavali pun deo, možete doživeti neprijatna iznenađenja. 
Potpuno uslovljavanje (engl. fully constraining) konvertovane skice obavlja se u dve faze: geome-
trijsko uslovljavanje i dodavanje parametarskih mera.

GEOMETRIJSKO USLOVLJAVANJE
Najpre izvršite neophodne ispravke geometrije koju je Mechanical Desktop automatski uneo 
konvertujući skicu. Uklonite nepotrebne uslove i unesite one koje Mechanical Desktop nije 
razumeo. Na primer, uklonite uslov koncentričnosti dva kruga koji je Mechanical Desktop 
uneo zato što su centri dva kruga na vašoj prvobitnoj skici bili međusobno blizu ili uvedite 
uslov horizontalnosti prave koji Mechanical Desktop nije uneo jer je na prvobitnoj skici pra-
va mnogo odstupala od horizontale. Simboli na slici 2-3 prikazuju geometrijske uslove prime-
njene na skicu.

Slika 2-3 Simboli geometrijskih uslova

DODAVANJE PARAMETARSKIH MERA
Da biste potpuno definisali skicu, osim geometrijskog uslovljavanja treba i da joj dodate parame-
tarske mere. Mere možete unositi na skicu kao brojne vrednosti ili kao izraze. Na primer, 
možete uneti uslov da dužina i širina pravougaonika uvek moraju da budu u određenom odno-
su. Isto tako, ovde unosite i parametre koji upravljaju merama niza punih delova. Na slici 2-4 
prikazane su parametarske mere skice.
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Slika 2-4 Parametarske mere dodate skici

OPCIJE
Već ste naučili da vaša skica ne mora da bude precizna jer će je Mechanical Desktop automat-
ski popraviti – dodati joj potrebna geometrijska ograničenja. To daje povoda za dva pitanja:

Koliko neprecizna skica može da bude?
Kako Mechanical Desktop tumači skicu?

KOLIKO NEPRECIZNA SKICA MOŽE DA BUDE?
Nepreciznošću skice možete upravljati zadajući dužinske i ugaone tolerancije pomoću dve 
sistemske promenljive: PICKBOX i AMSKANGTOL.

Tolerancija dužine
Promenljiva PICKBOX određuje linearno rastojanje u ekranskim tačkama (pikselima). Kada je 
njena vrednost, na primer, podešena na pet piksela, dve krajnje tačke će se spojiti ako prikaz 
na ekranu tako smanjite da njihovo međusobno rastojanje bude manje od pet piksela. I obr-
nuto, dve krajnje tačke se ne spajaju kada dovoljno povećate prikaz jer je njihovo rastojanje 
veće od veličine zadate promenljivom PICKBOX. S druge strane, ako prikaz veoma smanjite, više 
temena će se približiti na rastojanje manje od pet piksela navedenih u primeru i spojiti u je-
dinstveno teme, zbog čega ćete možda izgubiti neke pravolinijske segmente. Prema tome, vred-
nost promenljive PICKBOX ne treba da bude ni premala ni prevelika. Sada uradite sledeće:

1. Otvorite novu datoteku delova prema šablonu acadiso.

2. Izaberite Part>Part Options, a zatim karticu Selection (slika 2-5).

3. Na kartici Selection pomerajte klizač u području Pickbox Size. Time menjate veličinu 
područja spajanja krajnjih tačaka (što možete pratiti na sličici levo od klizača).

4. Pritisnite dugme Apply.



02_MDE5.indd    strana 27

27Parametarsko skiciranje

Slika 2-5 Kartica Selection okvira za dijalog Options

Tolerancija ugla
Promenljiva AMSKANGTOL definiše ugaono rastojanje. Na primer, ako je njena vrednost 4, prave čiji 
je nagib ka horizontali manji od 4 stepena, biće protumačene kao horizontalne. Sada nastavite:

5. Izaberite karticu AM:Part okvira za dijalog Options.

6. Podesite ugaonu toleranciju na 4 stepena ukoliko već nije izabrana ta vrednost.

7. Pritisnite dugme Apply.

KAKO MECHANICAL DESKTOP TUMAČI SKICU?
Pomoću sistemskih promenljivih AMRULEMODE i AMSKMODE možete da utičete na to kako će 
Mechanical Desktop protumačiti (konvertovati) vašu skicu.

Kao što je rečeno, tokom konvertovanja skice Mechanical Desktop primenjuje dva skupa 
pravila. Međutim, postoje situacije kada ne želite da na skicu primenite prvi skup geometrij-
skih pravila, već samo da povežete krajnje tačke. Tada treba da upotrebite promenljivu AM-

RULEMODE.
Ponekad ćete poželeti da dobijete pravu pod nagibom od tačno 3 stepena, bez obzira na to 

što je ugaona tolerancija za celu skicu podešena na 4 stepena. Da biste zanemarili zadatu ug-
aonu toleranciju i dobili skicu odgovarajuće preciznosti, u ovom slučaju iskoristite promenlji-
vu AMSKMODE. Nastavite prema sledećem:

8. Na kartici AM:Part okvira za dijalog Options proverite da li su potvrđene opcije Apply Con-
straint Rules (AMRULEMODE) i Assume Rough Sketch (AMSKMODE) (slika 2-6).

 Napomena:  Potvrđivanjem ovih opcija, promenljive AMRULEMODE i AMSKMODE dobijaju 
vrednost 1, pa se pravila primenjuju. Ove opcije su podrazumevano uključene.

9. Pritisnite dugme OK da biste zatvorili okvir za dijalog Options.
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Slika 2-6 Kartica AM:Part okvira za dijalog Options

OSTALI PARAMETRI
Osim opcija Apply Constraint Rules, Assume Rough Sketch i Angular Tolerance, na kartici 
AM:Part okvira za dijalog Options mogu se podesiti i drugi parametri:

Opcija Čemu služi

Apply to Linetype Tip linije koji ovde izaberete biće u parametarskoj skici iskorišćen za 
pravljenje elementa punog tela. Svaki drugi tip linije na skici biće 
smatran konstrukcionim objektom.

Constraint Size Ovo dugme omogućava da promenite visinu simbola uslova dok ih 
gledate na ekranu, menjate ili brišete.

Suppressed Dimensions 
and DOFs

Možete da promenite boju kota koje se odnose na potisnute elemente. 
U suprotnom, imaće svojstva boje tekućeg sloja. Ovim parametrom 
možete da podesite i boju simbola „stepen slobode“ (engl. degree of 
freedom, DOF).

Save File Format Ako je potvrđeno polje Compress, model će biti snimljen u kompri-
movanu datoteku koja zauzima manje memorije. Međutim, kasnije će 
se duže otvarati jer je potrebno vreme da se dekomprimuje.

Naming Prefix Ovde zadajete podrazumevani prefiks za imena delova i konstruk-
cionih alatki u datoteci.

KONSTRUISANJE PARAMETARSKE SKICE
Parametarska skica se pravi u četiri faze: skiciranje, konvertovanje, zadavanje geometrijskih 
uslova, dodavanje parametarskih mera.
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RAVAN CRTANJA
Pre nego što napravite skicu, treba da odredite ravan na kojoj ćete je crtati. Ravan crtanja (engl. 
sketch plane) za prvi element punog dela može da bude ravan XY tekućeg korisničkog koordi-
natnog sistema. Za sledeće skice punog tela tu ravan morate izričito definisati. O ravnima 
crtanja i srodnim konstrukcionim elementima više ćemo govoriti kasnije.

CRTANJE
Skicu sastavljate od AutoCAD-ovih elemenata: jednostavnih i složenih pravih linija, lukova, 
krugova, elipsi i krivih linija. Zbog toga morate poznavati AutoCAD, ali ne u detalje jer ne 
morate da konstruišete precizno – pomoću pobrojanih elemenata treba da napravite samo gru-
bu skicu. Da biste bolje „osetili“ veličinu skice koju pravite, uvećajte prikaz na ekranu do 
odgovarajuće poznate veličine.

10. Izaberite Assist>Format>Drawing Limits.

11. Na komandnu liniju unesite 0,0 da biste zadali položaj levog donjeg ugla.

12. Zatim na komandnu liniju unesite 100,80 da biste zadali položaj desnog gornjeg ugla.

13. Izaberite View>Zoom>All.

Na ekranu je sada područje približne veličine 100 × 80 jedinica. Sada možete preći na ski-
ciranje.

14. Napravite skicu rukovodeći se slikom 2-7, koristeći uobičajene AutoCAD-ove komande, kao 
što su LINE i FILLET.

Slika 2-7 Konstruisanja skica

KONVERTOVANJE SKICE
Skica koju ste napravili podrazumevano je AutoCAD-ova skica, znači – neparametarska. 
Morate je konvertovati u parametarsku skicu Mechanical Desktopa. U zavisnosti od namene 
parametarske skice, transformisaćete je u jedan od više vrsta objekata. Kada je transformišete 
u profil, možete da izaberete Single Profile (ukoliko postoji samo jedan objekat: krug, elipsa 
ili složena linija) ili Profile iz podmenija Sketch Solving menija Part (ukoliko ima više obje-
kata). Sada nastavite prema sledećem:

15. Izaberite Part>Sketch Solving>Profile ili alatku Profile s palete alatki Part Modeling (slika 2-8).

16. Izaberite linije i lukove, i pritisnite taster ENTER.

Ako skica predstavlja jedinstven objekat: pravougaonik, krug ili složenu liniju (engl. poly-
line), koraci 15 i 16 mogu se objediniti prema sledećem:

Izaberite Part>Sketch Solving>Single Profile.
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Slika 2-8 Skica konvertovana u profil

Pošto konvertujete skicu, na komandnoj liniji ćete ugledati zahtev za unos „Solved under 
constrained sketch requiring ?? dimensions or constraints“ (konvertovano u skicu za koju je 
potrebno ?? mera ili uslova). Umesto simbola „??“ pojaviće se broj parametarskih mera ili 
geometrijskih uslova koje treba da dodate konvertovanoj skici da biste je potpuno definisali. 
Pošto gruba skica sa slike 2-7 ne izgleda identično skici koju ste vi napravili, geometrijski uslovi 
koje Mechanical Desktop automatski primenjuje razlikovaće se u ta dva slučaja. Zbog toga će 
se razlikovati i broj parametarskih mera, odnosno geometrijskih uslova koje treba naknadno 
da unesete.

ZADAVANJE GEOMETRIJSKIH USLOVA
Da biste konvertovanu skicu propisno definisali, treba da uklonite neke od uslova koje je Me-
chanical Desktop automatski dodao i da unesete dodatne uslove. Pre nego što s tim započnete, 
treba da utvrdite koji su uslovi već dodati.

Prikazivanje simbola uslova
Sada ćete utvrditi koji su geometrijski uslovi primenjeni na vašu skicu. Naglasimo opet da se 
ono što ovde prikazujemo može razlikovati od onoga što ste vi dobili, pa će i primenjeni uslovi 
biti drugačiji. Međutim, svakako ćete na skici pronaći tzv. fiksnu tačku (engl. fixed point). Shod-
no svom imenu, ona se ne može pomerati.

17. Izaberite Part>2D Constraints>Show Constraints ili alatku Show Constraints s palete alatki 
2D Constraints.

Na slici 2-9 vidite brojeve unutar kružića i slovne oznake. Brojevi su imena elemenata. Slo-
va označavaju geometrijske uslove. Na primer, T1 znači da je element uz koji se oznaka nalazi 
tangencijalan elementu broj 1. Na sledećoj listi navedeni su svi geometrijski uslovi.

H Horizontalnost

V Vertikalnost

L Upravnost
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P Paralelnost

T Tangencijalnost

C Kolinearnost

N Koncentričnost

J Projektivnost

X Jednakost koordinate X za centralne i krajnje tačke

Y Jednakost koordinate Y za centralne i krajnje tačke

R Jednakost poluprečnika

E Jednakost dužine

M Osnosimetrično preslikavanje (kao u ogledalu)

F Fiksna tačka

Slika 2-9 Prikazivanje simbola uslova

Veličina prikaza simbola uslova
Veličinu prikaza simbola koji označavaju uslove zadajete na kartici AM:Part okvira za dijalog 
Options.

18. Izaberite Part>Part Options.

19. Na kartici AM:Part okvira za dijalog Options pritisnite dugme Constraint Size.

20. U okviru za dijalog Constraint Display Size, pomoću klizača podesite veličinu prikaza, iza-
berite Apply and Close, a zatim pritisnite dugme OK.

Uklanjanje i dodavanje geometrijskih uslova
Geometrijske uslove možete uklanjati ili ih dodavati pomoću odgovarajućih komandi iz meni-
ja Part ili s palete alatki 2D Constraints prikazane na slici 2-10.
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Uklanjanje uslova

Vertikalnost
Horizontalnost
Upravnost

Projektivnost

Vrednost X
Spoj

Paralelnost
Kolinearnost

Koncentriånost
Tangencijalnost Osnosimetriåno preslikavanje

Jednakost dužine

Jednakost polupreånika
Vrednost Y

Fiksna taåka

Slika 2-10 Komande za uklanjanje i dodavanje geometrijskih uslova

Pretpostavimo sada da imamo sledeće zahteve (brojevi pravolinijskih segmenata odgova-
raju slici 2-9):

Linije 0, 2, 4, 8, 10 i 12 horizontalnost
Linije 1, 3, 6, 9, 11 i 13 vertikalnost
Linije 3 i 9 kolinearnost
Linije 1 i 11 nekolinearnost
Linije 0 i 4 nekolinearnost
Linije 8 i 12 nekolinearnost
Luk 5 i linija 4 tangencijalnost
Luk 5 i linija 6 tangencijalnost
Luk 7 i linija 6 tangencijalnost
Luk 7 i linija 8 tangencijalnost
Lukovi 5 i 7 jednakost poluprečnika

Rukovodeći se navedenom tabelom, uklonite neželjene uslove.
21. Izaberite Part>2D Constraints>Delete Constraints ili alatku Delete Constraints sa paleti alat-

ki 2D Constraints.

22. Izaberite uslove koje ne sadrži navedena tabela i pritisnite ENTER.

Nedostajuće uslove dodaćete na sledeći način:
23. Izaberite Part>2D Constraints, a zatim izaberite odgovarajući uslov.

24. Izaberite element na koji ćete primeniti uslov.

U zavisnosti od toga da li je uslov već primenjen ili nije, dobićete jedan od sledećih zahteva 
za unos:

This constraint already exists. Enter an option. 
Solved under constrained sketch requiring ?? dimensions 
or constraints.

This constraint cannot be added. Existing dimensions, con-
straints, or a fix constraint prevent the constraint from 
being applied.
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što znači sledeće:
Ovaj uslov već postoji. Unesite opciju. 
Konvertovano u skicu za koju je potrebno ?? mera ili uslova.
Ovaj uslov se ne može zadati. Postojeće mere, uslovi ili fiksna 
tačka onemogućavaju da se on primeni.

Simboli „??“ u drugom navedenom zahtevu za unos zamenjuju broj koji se smanjuje za 1 
kad god dodate uslov. Nastavite da unosite uslove u skladu s navedenim zahtevima. Na slici 
2-11 prikazana je propisno definisana skica. 

Slika 2-11 Neželjeni uslovi su uklonjeni, a odgovarajući dodati

KORIŠĆENJE PARAMETARSKIH MERA
Poslednji korak u konstruisanju parametarske skice jeste unošenje parametarskih mera. Pre 
nego što to uradite, morate da zadate opšti stil kotiranja i metodu prikazivanja mera.

Stil kotiranja
Opšti stil kotiranja obuhvata formate, npr. visinu teksta, veličinu strelica itd. Sada ćete zadati 
opšti stil kotiranja i izabrati metodu prikazivanja mera.

25. Izaberite Annotate>Edit Dimensions>Dimension Style (slika 2-12).

26. U okviru za dijalog Dimension Style Manager pritisnite dugme Modify, na odgovarajući na-
čin podesite parametre stila i zatvorite okvir za dijalog pritiskom na dugme Close.

Slika 2-12 Okvir za dijalog Dimension Style Manager
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Metoda prikazivanja mera
Metoda prikazivanja parametarskih mera određuje kako ćete ih videti na ekranu. Postoje tri me-
tode: numerički prikaz, parametarski prikaz i prikaz pomoću jednačina. Numerički prikaz vam 
omogućava da neposredno vidite vrednosti mera. U parametarskom prikazu, pored mere biće 
navedeno ime odgovarajućeg parametra. Prva mera koju dodate na skicu nosiće ime d0, druga 
d1 itd. Zbog toga, imena vaših mera ne moraju odgovarati merama sa slika u ovoj knjizi jer ona 
zavise od redosleda dodeljivanja mera. Dobro bi bilo da njihova imena zapišete na papiru kako 
biste mogli lakše pratiti primere iz knjige. U trećoj metodi, vrednost mere se izražava jednačinom: 
ime parametra jednako je nekom izrazu. Sada ćete izabrati metodu prikazivanja mera.

27. Izaberite Part>Dimensioning>Dimensions As Equation to use equation display.

Unošenje mera
Sada ćete na konvertovanu skicu uneti mere. Za to postoje dve komande: AMPARDIM (NEW DI-

MENSION) i AMPOWERDIM (Power Dimensioning) (slika 2-13). Komande rade slično, osim što 
AMPOWERDIM omogućava i da zadate položaj pomoćnih linija. Na slici 2-14 prikazane su mere 
koje treba da unesete.

Slika 2-13 Komande Power Dimensioning i New Dimension

Slika 2-14 Mere koje treba uneti

Počnite od spoljnih mera.
28. Izaberite Part>Dimensioning>New Dimension ili alatku New Dimension sa palete alatki 2D 

Constraint.

29. Izaberite A na slici 2-14 da biste zadali prvi objekat.

30. Izaberite B na slici 2-14 da biste zadali drugi objekat.

31. Izaberite C na slici 2-14 da biste zadali mesto za postavljanje kote.
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Pošto ste izabrali objekte i mesto za postavljanje kota, na komandnoj liniji ćete ugledati iz-
merenu vrednost mere. Umesto simbola „??“ u sledećem zahtevu za unos pojaviće se tačna 
vrednost mere.

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/
Diameter/pLace] <??>:

što znači sledeće:
Unesite vrednost mere ili [Undo/Hor/Ver/Align/Par/aNgle/Ord/
Diameter/pLace] <??>:

Da biste meru promenili na zahtevanu vrednost 90, upišite 90 na komandnu liniju. Pre toga 
obavezno uporedite izmerenu vrednost sa zahtevanom. Ako je izmerena vrednost mnogo veća, 
recimo 200, a vi upišete 90, mera će se smanjiti sa 200 na 90 jedinica.

Pošto se druge mere neće izmeniti, profil će se izobličiti i dobićete rezultat kao na slici      
2-15. Prema tome, ne upisujte 90 ako je izmerena vrednost mnogo veća. Upišite U da biste 
opciju poništili.

S druge strane, ako je izmerena vrednost manja od 90, a vi upišete 90, spoljna mera će se 
rastegnuti i dobićete rezultat kao na slici 2-16. Ovde se oblik nije promenio, pa možete nasta-
viti da dodajete ostale mere.

Slika 2-15 Veliko smanjenje spoljne mere izaziva izobličenje profila

Slika 2-16 Spoljna mera je povećana, ostale nisu promenjene

Usvojite pravilo da uvek uporedite izmerenu vrednost mere na komandnoj liniji s njenom 
zahtevanom vrednošću pre nego što tu vrednost upišete. Ako počnete od spoljnih mera pro-
fila, a izmerena vrednost je mnogo veća od zahtevane, komandu treba da poništite – inače će 
se profil izobličiti. Kod skica koje su mnogo veće nego što je potrebno, počnite unošenje mera 
od najmanje mere i tako nastavite sa sve većim merama dok ne dobijete poruku „Solved fully 
constrained sketch“ (Konvertovana je potpuno uslovljena skica). Da biste prekinuli komandu, 
pritisnite ENTER. Pošto ste možda mere unosili drugačijim redosledom, imena vaših mera možda 
neće odgovarati imenima sa slike 2-17.
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Slika 2-17 Konvertovana skica na koju su unete sve mere

Kao što i sami vidite, mere A i B na slici 2-17 jednake su. Umesto da zadajete dve vred-
nosti mera, možete da zadate uslov da je mera A jednaka meri B. Na slici 2-17 ime parame-
tra za meru B je d2. Međutim, ime parametra za meru B na vašem crtežu ne mora biti d2, već 
d?, gde je „?“ broj koji odgovara redosledu kojim ste dodavali mere. (Setite se da je d0 prva 
mera na crtežu, d1 je druga itd.) Ime d2 treba da zamenite imenom parametra za meru B na 
svom crtežu, na način prikazan u sledećem odeljku.

Menjanje parametarskih mera
Mere podešavate pomoću komandi AMMODDIM (EDIT DIMENSION) i AMPOWEREDIT (POWER EDIT) 
(slika 2-18). Pomoću komande AMMODDIM možete da promenite samo vrednost mere, a pomoću 
komande AMPOWEREDIT i razne druge aspekte mere, kao što su format, geometrija i merne je-
dinice.

Slika 2-18 Komande Power Edit i Edit Dimension

Sada ćete meru B izjednačiti s merom A.
32. Izaberite Part>Dimensioning>Edit Dimension ili alatku Edit Dimension sa palete alatki 2D 

Constraints.

33. Izaberite meru d2 prema slici 2-19.

34. Na komandnu liniju upišite d1.

Mera d2 će se promeniti (slika 2-19). Sada ćete izmeniti meru A.
35. Izaberite A prema slici 2-19.
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36. Upišite 20.

37. Pritisnite ENTER da biste završili komandu.

Slika 2-19 Mera d2 izjednačena je sa merom d1

Pošto promenite meru A, promeniće se i mera B jer je jednaka meri A (slika 2-20). Para-
metarska skica je time dovršena. Snimite datoteku (ime datoteke Profile.dwg).

Slika 2-20 Mere su se promenile

PRETRAŽIVAČI OBJEKATA
Pretraživači objekata (engl. desktop browsers) prikazuju hijerarhiju objekata u datoteci. Skice i 
elementi koje konstruišete prikazaće se kao objekti u hijerarhiji. Osim što precizno prikazuju 
hijerarhiju objekata u datoteci, pretraživači obezbeđuju i prečice ka komandama, i kontrole za 
konstruisanje delova, elemenata, sklopova i crteža. Pritiskajući unutar pretraživača desnim taste-
rom miša, otvarate konstekstni meni. Birajući različite kartice pretraživača menjate radne 
režime i aktivirate odgovarajuće palete alatki. Pri tome se komande koje možete primeniti pri-
kazuju jasno, dole su neprimenljive komande prikazane bledo. Pogledajte svoj ekran. Ako pre-
traživač objekata nije na njemu, aktivirajte ga komandom View>Display>Desktop Browser.
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VRSTE PRETRAŽIVAČA
Pošto postoje dve vrste datoteka, postoje i dva pretraživača: pretraživač delova i pretraživač 
sklopova. Na slici 2-21 prikazani su pretraživač datoteka delova (desno) i pretraživač datote-
ka sklopova (levo).

Slika 2-21 Pretraživač datoteka sklopova (levo) i pretraživač datoteka delova (desno)

Pretraživač datoteka delova ima dve kartice: Model i Drawing. Na kartici Model nalaze se 
kontrole za konstruisanje punih delova i elemenata, a kartica Drawing obezbeđuje kontrole 
za pravljenje crteža. Pretraživač datoteka sklopova ima tri kartice: Model, Scene i Drawing. 
Kartica Scene služi za konstruisanje scene sklopa. (O kartici Scene više ćemo govoriti u 6. po-
glavlju, a o kartici Drawing u 9. poglavlju.) U dnu prozora pretraživača nalazi se sedam dug-
madi, opisanih u sledećoj tabeli.

Prekidač Part Filter Upravlja prikazom delova i elemenata u pretraživaču
Prekidač Assembly Filter Upravlja prikazom sklopa i uslova
Dugme Options Prikazuje okvir za dijalog Options
Dugme Catalog Prikazuje okvir za dijalog Catalog
Dugme Visibility Prikazuje okvir za dijalog Desktop Visibility
Dugme Update Part Ažurira pun deo
Dugme Updte Assembly Ažurira sklop

Minimiziranje pretraživača
Kada je pretraživač aktivan, on zauzima deo radne površine. Ako radnu površinu želite da rašči-
stite, možete zatvoriti ili minimizovati pretraživač. Pretraživač zatvarate pritiskom na dugme 
[x] u gornjem desnom uglu njegovog prozora. Ako samo želite da ga minimizujete, dovucite 
ga u centralni deo ekrana, nadnesite kursor nad njegov okvir i dvaput pritisnite taster miša 
(slika 2-22). Kada ponovo želite da ga otvorite, samo dvaput pritisnite njegov minimizovani 
okvir.
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Slika 2-22 Minimizovani pretraživač

TEHNIKE SKICIRANJA
Odnose između objekata na skici uspostavljate služeći se pravilima geometrijskog konstruisanja. 
Tokom projektovanja, često ćemo menjati skicu iz raznoraznih razloga. Prema tome, vaš za-
datak će biti da konvertovanoj skici dodajete ili da iz nje uklanjate određene elemente. U dato-
teci delova možete da napravite više skica pre nego što s njima išta dalje preduzmete. Uobičajeno 
je da se uz puna tela uključuju i tekstualni objekti koje ćete takođe napraviti kao skicu.

KORIŠĆENJE KONSTRUKCIONIH POMOĆNIH ELEMENATA
Pri geometrijskom konstruisanju koristite posebne (pomoćne) elemente parametarske skice. 
Pomoću tih konstrukcionih elemenata primenjujete geometrijske uslove i parametarske mere, 
ali se oni ne koriste u naknadnim operacijama. Na primer, pomoću konstrukcione linije definišete 
osu simetrije ili vam konstrukciona linija služi da poravnate krajnje tačke više duži. Kada 
razvučete skicu, konstrukcioni elementi se neće razvući. Da biste konstrukcione elemente ra-
zlikovali od drugih elemenata, crtajte ih drugačijom vrstom linije.

Sada preduzmite sledeće korake da biste konstruisali skicu potrebnu za pravljenje izvučenog 
elementa modela sa slike 2-23.

Slika 2-23 Sedište dečjeg automobila

1. Otvorite novu datoteku delova polazeći od šablona acadiso.

2. Zadajte granice crteža (1000 × 800 jedinica) i uvećajte njegov prikaz do veličine ekrana.

3. Konstruišite nekoliko pravolinijskih segmenata prema slici 2-24. Element 2 je skrivena linija i 
pri konvertovanju skice biće smatran konstrukcionom linijom. Konstrukcione linije možete 
konstruisati komandom Construction Line koja se nalazi na paleti alatki 2D Sketch.

4. Konvertujte skicu (zajedno s nevidljivom duži) u profil.

5. Dodajte geometrijske uslove horizontalnosti, vertikalnosti i osnosimetričnog preslikavanja, 
kao na slici 2-24.
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Slika 2-24 Geometrijski uslovi primenjeni na konvertovanu skicu

6. Dodajte parametarske mere, kao što je prikazano na slici 2–25.

Time je dovršena skica elementa punog tela koje predstavlja sedište dečjeg automobila. 
Snimite datoteku pod imenom Seat.dwg.

Slika 2-25 Dodate su parametarske mere

Sada ćete konstruisati skicu za pravljenje gume dečjeg automobila. Na slici 2-26 prikazan 
je dovršen model.

Slika 2-26 Guma za dečji automobil

1. Otvorite novu datoteku delova polazeći od šablona acadiso.

2. Konstruišite skicu rukovodeći se slikom 2-27. Elementi 0, 1 i 2 nevidljivi su i koristiće se kao 
konstrukcione linije.

3. Konvertujte skicu u profil i zadajte geometrijske uslove.

4. Unesite parametarske mere prema slici 2-28.

Skica je time dovršena. Snimite je u datoteku Tire.dwg.



02_MDE5.indd    strana 41

41Parametarsko skiciranje

Slika 2-27 Skica je konvertovana i na nju su primenjeni geometrijski uslovi

Slika 2-28 Unete su parametarske mere

DOPUNJAVANJE I KONVERTOVANJE SKICE
Oblik i veličinu parametarske skice menjate tako što manipulišete njenim geometrijskim uslo-
vima i parametarskim merama. Ako želite da parametarsku skicu dopunite novim AutoCAD 
elementima, konstruišite ih i dodajte skici. Isto tako, iz parametarske skice možete da uklanjate 
objekte, a možete je i menjati. Kada uradite sve što hoćete, konvertujte skicu.

Sada ćete izmeniti konvertovanu skicu gume dečjeg automobila.
1. Otvorite datoteku Tire.dwg (ukoliko ste je u međuvremenu zatvorili).

2. Uklonite duž i dodajte luk tako da skica odgovara slici 2-29.

3. Izaberite Part>Sketch Solving>Append ili izaberite skicu u pretraživaču, pritisnite je desnim 
tasterom miša i iz priručnog menija izaberite Append.

4. Izaberite luk i pritisnite ENTER.
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Slika 2-29 Jedna duž je uklonjena i dodat je luk

5. Izaberite Part>Sketch Solving>Resolve, pritisnite Resolve Sketch na paleti alatki Part Model-
ing ili izaberite crtež u pretraživaču, pritisnite ga desnim tasterom miša i izaberite Resolve.

6. Zadajte luku geometrijske uslove (tangencijalnost) prema slici 2-30.

Izmene su završene. Snimite datoteku.

Slika 2-30 Skica gume sa dodatim geometrijskim uslovima i parametarskim merama

PRIPREMANJE VIŠE SKICA
Pomoću konvertovane skice konstruišete različite elemente punog tela. Pošto na skicu prime-
nite neku operaciju, kaže se da je skica „potrošena“ (engl. consumed). Da biste na skicu mogli 
da primenite više operacija, morate imati više skica.

Sada ćete konstruisati drugu skicu u datoteci Tire.dwg.
1. Ako ste datoteku Tire.dwg zatvorili, otvorite je ponovo.

2. Rukovodeći se slikom 2-31, konstruišite tri duži i luk, konvertujte duži i luk u drugi profil i do-
dajte mu geometrijske uslove.



02_MDE5.indd    strana 43

43Parametarsko skiciranje

Slika 2-31 Konvertovan drugi profil

Obratite pažnju na to da se u pretraživaču sada pojavljuju dva profila.
3. Unesite parametarske mere u skladu sa slikom 2-32.

Druga skica je gotova. Snimite datoteku i zatvorite je.

Slika 2-32 Dodate su parametarske mere

KONSTRUISANJE SKICE TEKSTA
Tekstualni objekat je posebna vrsta skice. Koristite ga da biste konstruisali puna tela čiji oblik 
odgovara obliku tekstualnog niza. Sada ćete konstruisati skicu teksta u datoteci Seat.dwg.

1. Otvorite datoteku Seat.dwg ako već nije otvorena.

2. Izaberite Part>Sketch Solving>Text Sketch ili alatku Text Sketch sa palete alatki Part 
Modeling.
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3. U okviru za dijalog Text Sketch izaberite ime fonta i stil, upišite tekst i pritisnite dugme OK 
(slika 2-33).

Slika 2-33 Okvir za dijalog Text Sketch

4. Rukovodeći se slikom 2-34, izaberite dve tačke koje će označiti položaj skice teksta.

5. Pritisnite dvaput parametarsku meru da biste promenili visinu slova.

Gotova je i druga skica – tekstualna. Snimite datoteku i zatvorite je.

Slika 2-34 Konstruisana skica teksta

DRUGE TEHNIKE SKICIRANJA
Za svaku skicu vam treba ravan crtanja. To je podrazumevano ravan XY standardnog koordi-
natnog sistema (engl. World Coordinate System, WCS). Osim nje, možete koristiti i postojeće 
stranice punog tela ako ste ga već konstruisali. (Imajte na umu da je zadavanje ravni crtanja u 
Mechanical Desktopu jednako uspostavljanju korisničkog koordinatnog sistema (engl. User 
Coordinate System, UCS) u AutoCAD-u.
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Kopiranje skica
Ako ste već konstruisali skicu ili element, novu skicu možete da konstruišete tako što ćete 
kopirati skicu ili skicu elementa. Na taj način ubrzavate postupak konstruisanja skica.

Kopiranje ivica
Ivice punih elemenata u ravni crtanja takođe se mogu ponovo koristiti. Kada kopirate ivicu, 
ona postaje deo nove skice. U 3. poglavlju ćete naučiti da ravan crtanja postavite na stranicu 
punog tela i da kopirate skicu elementa, a u 4. poglavlju – kako se kopira ivica punog tela.

SAŽETAK

Konstruisanje parametarskog punog dela počinje pravljenjem parametarske skice, što 
podrazumeva četiri osnovna koraka. Za konstruisanje skice u ravni za crtanje služite se 
AutoCAD-ovim alatkama za crtanje krivih. Pošto tako podrazumevano dobijate AutoCAD-
-ovu neparametarsku skicu, pomoću Mechanical Desktopa je konvertujete u parametar-
sku. Način konvertovanja skice zavisi od njene namene, pa je možete konvertovati u profil, 
putanju, liniju preloma, liniju preseka ili liniju cepanja. (U ovom poglavlju ste naučili da je 
konvertujete u profil.)

Pošto skicu konvertujete, treba da pregledate geometrijske uslove koje je Mechanical Desk-
top automatski u nju uneo i da neke odbacite, a neke dodate – shodno onome šta ste za-
mislili. Na kraju, na skicu unosite parametarske mere koje joj daju pravu veličinu. Tokom 
pravljenja skice možete se služiti pomoćnim konstrukcionim elementima da biste lakše 
uspostavili geometrijske uslove i parametarske mere. Ti pomoćni elementi ne učestvuju u 
naknadnim operacijama nad skicom. Završenu parametarsku skicu možete menjati doda-
vanjem i/ili uklanjanjem elemenata i njihovim konvertovanjem.
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PITANJA ZA PROVERU ZNANJA

1. Navedite četiri opcije na kartici AM:Part okvira za dijalog Options koje utiču na konvertovanje 
skice u profil.

2. Kada konstruišete skicu za konvertovanje u profil, linije ne morate tačno spajati. Kolika sme da 
bude nepreciznost spajanja?

3. Ako se konstruiše skica tačnih mera i oblika, da li je treba konvertovati?

4. Može li se geometrijski uslov ukloniti? Ako može, kako?

5. Kada u profilu treba da postoji mera pod određenim uglom, pojavljuje se horizontalna mera. 
Kako se ona može pretvoriti u meru pod određenim uglom?

6. Na koliko načina možete da konvertujete skicu? Navedite ih.

7. Navedite korake potrebne za konstruisanje parametarske skice.

8. Kako ćete na parametarsku skicu dodati element ili ga sa nje ukloniti?

9. Objasnite značenje konstrukcionih elemenata, korišćenja više skica i skice teksta.

10. Profil ne mora da bude potpuno uslovljen. Tačno ili netačno?

11. Na skici može biti više fiksnih tačaka. Tačno ili netačno?

12. Pošto se profil potpuno uslovi, vrednosti parametarskih mera ne mogu se menjati. Tačno ili 
netačno?
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